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1: Excel VBA Tutorials for | Beginners | Intermediate | Advanced Users
In this chapter, you will learn how to write a simple macro in a step by step manner. Step 1 âˆ’ First, enable 'Developer'
menu in Excel 20XX. To do the same, click File â†’ Options. Step 2 âˆ’ Click 'Customize the Ribbon' tab and check
'Developer'. Click 'OK'. Step 3 âˆ’ The 'Developer' ribbon.

Print this page to read it at home, at the office, on the bus or the train Excel Macros Section 1: You will
discover that: It is a very user-friendly development environment. Notes Special note for users of Excel Until
the versions of Excel the user did not need to install anything to work with macros in Excel. At any time if you
feel uncomfortable, just close Excel without saving the workbook and try again later. For users of Excel to
The first thing that you need to do is to make sure that the security level of Excel is set at either "Low" or
"Medium" so that you can use the macros VBA procedures that you develop. From the "Developer" ribbon
click on the "Macro Security" button. Check the second level "Disable all Macros with Notification" and you
are set. We will open it and start by setting it up so that working within it becomes easy and efficient. Print
this page, open Excel and open a new workbook Book1. If there are any open windows within the VBE like in
the image below click on the Xs to close them and see a gray rectangle filling up the bottom part of the screen
like in the image above. We will study each of the three windows in lessons 2, 3 and 4 but first we will set
them up in the VBE. Close all the windows that are open in the VBE to end up with this: Go to the menu bar
"View" and click "Project Explorer". The result will be somewhat like the image below: If the project window
already appears as a column on the left side of the screen there is nothing else that you have to do for now. If
the project window appears in the middle of the gray area like above, right-click in the white space in the
middle of the project window and check "Dockable". When you let go of the mouse button the end result
should be like shown in the image below. Congratulations you have setup the first major window of the VBE.
Move your cursor on the line separating the project window and the gray rectangle. Go back to the menu bar
"View" and click "Properties Window". The Properties window will appear somewhat like in the image
below. If the Properties window is already located below the Project window there is nothing left to do. When
you let go of the mouse button the end result should be as the image below. Move your cursor on the line
separating the project window and the properties window. To add the code window to the setup, you just have
to double click on the name of a component in the Project window Sheet1, Sheet2, Sheet3 or ThisWorkbook
and its code window appears within the gray rectangle. The final result looks like the image below. The words
"Option Explicit" might not be present in your Code window. We will address this issue later in the lesson on
variables Lesson XLAM in the project window. Forget about this project for now. Now go to Excel and close
it. Congratulations, you are now ready to work in the Visual Basic Editor. Close the VBE and close Excel
without saving anything. Print this page, open Excel and a open a new workbook. Working within the Project
Window We will now complete a brief exercise to learn how easy it is to work within the Project Window.
Notice that the worksheets are sorted alphabetically in the Project window even if they are not in the
workbook. You can export and save these modules to be used later in other workbook. Notice that there are 2
"Name" properties. On the first line there is the programmatical name of the sheet Sheet1. You will discover
later the advantages and disadvantages of changing this property. The second "Name" property 9th line is the
name or caption that appears on the tab of the sheet in Excel. We will change the name Caption on the tab of
"sheet1" to "Introduction". To do so right-click on the tab of the sheet and the following dialog window
appears: The menu disappears and the name of Sheet1 is highlighted. The end result is illustrated in the image
below. We will now complete another smal exercise to change the name from the VBE Properties window.
Click "Enter" Step 2: Go to Excel and notice that you now have a sheet named "Spreadsheet". To see the
equivalent of the image below, select Sheet2 Spreadsheet in the Project window. Click on the word "Visible"
on the 12th line of the Properties window. You will also learn how to name your modules and work with a few
other properties of the objects appearing in the Project Window. Go to the Visual Basic Editor. Double click
on "Sheet1" in the Project Window. On the right is the Code window of "Sheet1" For the purpose of this
exercise we will develop a small macro within the code window of a sheet. You will later develop the habit of
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creating modules and organizing your macros within them. Click anywhere in the Code window Step 4: If you
decide to key it in you will start by entering the first line and then when you press enter the VBE will add the
final Line "End Sub". Enter the rest of the code within the two lines. Make sure that everything is there
including all the quotation marks, periods, parentheses, equal signs and spaces.
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2: Insert and run VBA macros in Excel , - step-by-step guide
Congratulations, you have completed the Excel tutorial that explains the VBA environment in Microsoft Excel Tutorial
Summary Excel is a version of Excel developed by Microsoft that runs on the Windows platform.

October 8, by Kasia Mikoluk Macros are little programs that run within Excel and help automate common
repetitive tasks. Using macros, you can save hours and boost productivity manifold. In this blog post, we will
learn how to create an ultra-simple macro in Excel to introduce you to the concept. For a more detailed
overview of advanced Excel functions, including creating complicated macros, try the comprehensive Excel
training course for beginners and intermediate users. What is a Macro? A macro can be defined as the
recording of a series of tasks. When used right, macros can save you hours by automating simple, repetitive
tasks. This is a version of Visual Basic a prominent Microsoft programming language developed specifically
for use in Office-like applications. Creating simple macros â€” copy a formula from one cell to another, for
instance â€” is fairly easy. Complicated macros require a bit more work. You can learn more about these in
this advanced Excel course. For this tutorial, we will create a very simple macro to get you up to speed with
Excel programming and automation. Activate the Developer Toolbar To write macros, you will need access to
the Developer toolbar in the top ribbon. This is hidden by default. You should now see the Developer toolbar
in the ribbon. Enable Macros Macros are disabled by default in Excel. This is to protect you from malicious
macros running automatically in downloaded Excel files. To use macros, you will have to first enable them
from the Trust Center. You can now start using macros in your Excel spreadsheets. Prepare the Spreadsheet In
this tutorial, we will create a very simple macro to change the color, size and boldness of text. In your
spreadsheet, type in some text in any of the cells. We will later record a macro to change the formatting of this
text. Now that our spreadsheet is ready, we can start creating the macro. Type in whatever you like over here.
It helps to be descriptive with your macro titles. You might end up using dozens of macros in a large
spreadsheet. Being able to quickly find individual macros by name will save you hours of frustration later.
Two important considerations here: The shortcut key gives you quick access to the macro. Using a custom
shortcut is highly recommended â€” you are using macros to save time, after all. In this drop down menu, you
can decide where to save the macro. Macros stored in this workbook are available across all your workbooks.
Think of it as a central repository for every macro that you create. The actual macro workbook file itself will
be hidden the Windows AppData folder, but it will load up automatically when you start Excel, giving you
complete access to all macros. Not sure how macros work? Your macro is now being recorded. Select the cell
where you entered your text. You have now successfully recorded an Excel macro! Add a few more blocks of
text to your spreadsheet, one cell at a time. You might have to change the default formatting back to black
font, 11 point font size and normal text. The formatting will immediately change to 18 pt. You can apply this
to each cell at a time, or select multiple cells together. The formatting changes that would otherwise take you
multiple clicks now take just one keystroke. This is one of the most basic macros you can create. As you can
imagine, complex macros can be created to perform very complicated tasks. You can learn more about
creating such macros with Excel VBA programming in this Excel training course for advanced topics. Was
this tutorial helpful? Share them with us in the comments below.
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3: A Beginner's Tutorial on Writing VBA Macros in Excel (And Why You Should Learn)
1 Create a Macro: With Excel VBA you can automate tasks in Excel by writing so called www.enganchecubano.com this
chapter, learn how to create a simple macro.. 2 MsgBox: The MsgBox is a dialog box in Excel VBA you can use to
inform the users of your program.

What is a macro? A macro is a piece of programming code that runs in Excel environment and helps automate
routine tasks. Some of the customers pay through the bank and at the end of the day, you are required to
download the data from the bank and format it in a format that meets your business requirements. You can
import the data into Excel and format. The following day you will be required to perform the same ritual. It
will soon become boring and tedious. Macros solve such problems by automating such routine tasks. You can
use a macro to record the steps of Importing the data Formatting it to meet your business reporting
requirements. It is a programming language that Excel uses to record your steps as you perform routine tasks.
You do not need to be a programmer or a very technical person to enjoy the benefits of macros in Excel. Excel
has features that automatically generated the source code for you. Read the article on Vba for more details.
Macro Basics Macros are one of the developer features. By default, the tab for developers is not displayed in
excel. You will need to display it via customize report Macros can be used to compromise your system by
attackers. By default, they are disabled in excel. Always fill in the description of the macro when creating one.
This will help you and others to understand what the macro is doing. Step by step example of recording
macros in Excel We will work with the scenario described in the importance of macros excel. We will work
with the following CSV file. You can download the above file here We will create a macro enabled template
that will import the above data and format it to meet our business reporting requirements. Enable the
developer option as shown below and pin it into your main ribbon in Excel. Create a folder in drive C named
Bank Receipts Paste the receipts. Step two will be there by default Enter the description as shown in the above
diagram Click on "OK" tab Put the cursor in cell A1 Click on the DATA tab Click on From Text button on the
Get External data ribbon bar You will get the following dialogue window Go to the local drive where you
have stored the CSV file Select the CSV file You will get the following wizard Click on Next button after
following the above steps Follow the above steps and click on next button Click on Finish button Your
workbook should now look as follows Make the columns bold, add the grand total and use the SUM function
to get the total amount. Now that we have finished our routine work, we can click on stop recording macro
button as shown in the image below Before we save our work book, we will need to delete the imported data.
We will do this to create a template that we will be copying every time we have new receipts and want to run
the ImportBankReceipts macro. Highlight all the imported data Right click on the highlighted data Click on
Delete Click on save as button Save the workbook in a macro enabled format as shown below Make a copy of
the newly saved template Open it.
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4: Excel VBA Tutorial - The Ultimate Excel VBA Tutorial
VBA is the acronym for Visual Basic for Applications. It is a programming language that Excel uses to record your steps
as you perform routine tasks. You do not need to be a programmer or a very technical person to enjoy the benefits of
macros in Excel.

When you finish this tutorial you will be able to: Try the examples and activities. Type the code examples
instead of copying and pasting â€” this will help you understand the code better. Have a clearly defined target
for learning VBA. One you will know when you reach. They help you write proper code. Start by creating
simple macros for your work. Then create more complex ones as you get better. The more times you do it the
more deeply embedded the knowledge will become. A macro is a group of programming instructions we use
to create automated tasks. VBA is the programming language we use to create macros. It is short for Visual
Basic for Applications. This a VBA instruction. Generally speaking, they perform one task. A sub is made up
of one or more lines of code. A macro and a sub are essentially the same thing. A module is simply a container
for our subs. A module contains subs which in turn contain lines of code. There is no limit within reason to the
number of modules in a workbook or the number of subs in a module. This is where we write our code. The
screenshot below show the main parts of the Visual Basic Editor Tip for the Activities When you are working
on the activities it is a good idea to close all other Excel workbooks. The term macro is essentially another
name for a sub. We place the lines of code in a sub. These subs are stored in modules. We can place our subs
in the module of the worksheet. However, we generally only place code for worksheet events here. In VBA,
we create new modules to hold most of our subs.
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5: Section 1: Programming in Excel (Macros)
Let's look at a simple VBA macro to see how it works. An Example of a VBA Macro in Excel. Let's look at a simple
macro. Our spreadsheet contains names of employees, the store number where the employees work, and their quarterly
sales.

If you follow the above tutorials step by step, you will be able to make any complicated project using Excel
VBA. Just you have to do a little practice. This channel is run by Daniel Strong. He has enriched his channel
with a huge number of video tutorials on Excel VBA. Whatever your problem is, you will get a solution with
this YouTube channel. It is true that there are plenty of free videos are there on YouTube on Excel VBA, but
what you need is a true guide who will start from basic, keep you engaged and on track with lessons, quizzes,
and other essential materials. What are you going to get from this course? I had a plan to make a course on
Excel VBA. Mark has been using Excel since version 1. And here are some reviews in his course. Started
writing a VBA code and did forget the syntax of a constructor? Just go to Google and convert your problems
in some phrases and hit Enter. Millions of results will appear to you immediately. Searching in a book for
some problems? It will take time. Go to the Index page, then count a, b, c, d, find out your relevant topic, go to
that page, and get an idea of your findings. A long-term process really and there is no guarantee that you will
find your problem topic in your book. Then why every expert says that you need a book on your topic? My
advice is same to you. You need one or two books in Excel VBA. It might be in PDF or it can be a hardcover
book preferable. When you will enroll in an online course on Excel VBA or on any topic , it is true that you
will learn almost all the topics within the shortest possible of time. But a video course can be compared with a
regular classroom where your instructor just gives you the general view of the topics. You then go home, open
the book and read the topics that you have learned in your classes and do some practice problems. So, still, at
this age of quick information, a book is an inevitable asset at your table. Here, I will give you a list of total 3
books that you can consider buying. These books are really helpful and the readers have shown their high
gratitude to the authors of these books through reviews. He is known as Excel GUY and if this is your first day
of introduction with Microsoft Excel, you may have heard his name.
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6: Master Microsoft Excel Macros and Excel VBA
With Excel VBA you can automate tasks in Excel by writing so called macros. In this chapter, learn how to create a
simple macro which will be executed after clicking on a command button. First, turn on the Developer tab. To turn on the
Developter tab, execute the following steps. 1. Right click.

If works similarly as the IF function in Excel formulas. Based on the condition it will return either one of 2
values. See the structure of the IIF statement below: See an example below: Print "Val2 is bigger or equal than
Val1" Else Debug. Print "Val1 is equal to Val2" End If Select â€” Case In some situation rather than create
conditions you simply want to enumerate a set of values and carry out different tasks. Select â€” Case with
specific values You can enumerate each case of a value. Print "The value is 6" Case 10 Debug. Print "The
value is 10" Case 11 Debug. Print "The value is 11" Case Else Debug. Print "Another value" End Select Select
â€” Case with ranges of values Alternatively you can express certain ranges of values. Print "The value is
between 1 and 5" Case 6 to 10 Debug. Print "The value is between 1 and 10" Case 11, 12, 13 Debug. Print
"The value is either 11, 12 or 13" Case Else Debug. Print "The value is less than or equal 30 or higher than 50"
Case Else Debug. Loops are a common programming concept allowing you to repeat a set of code until you
exit the loop. A common example could be looping through a list of grocery items or employees etc. Type
Example For Loop The basic type of loop. Executes the loop, increments the index until the index does not
exceed the maximum value. When referencing You can reference Excel cells in two ways: Using the Range
object â€” by the name of the range e. An Excel Cell is a single cell in an Excel worksheet assigned with a row
and column number. An Excel Range is a range of Excel Cells in an Excel worksheet that do not have to be
necessarily adjacent e.
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7: Excel VBA Tutorial for Beginners: Learn in 3 Days
As Mr. Excel (Bill Jelen) (another one of the foremost Excel wizards) and Tracy Syrstad (an Excel and Access
consultant) say in Excel VBA and Macros, recording a macro is helpful when you are beginner and have no experience
in macro programming but.

Twitter Advertisement Excel Macros can save you a ton of time by automating Excel processes that you use
often How to Record a Macro in Excel How to Record a Macro in Excel Did you know that you could
automate repetitive tasks in Microsoft Excel by using macros? But macros are actually quite limited. Using
VBA to create macros gives you a great deal more power. You can tell Excel exactly what to do and how to do
it. You also get access to a lot more functions and capabilities. Visual Basic is a programming language, and
VBA is the application-specific version of it. Fortunately for non-programmers, VBA is very simple, and the
interface that you use to edit it offers a lot of assistance. Still, VBA takes a while to get used to. The short
answer is that you get a lot more power out of VBA macros. You just need to know how to use them. Our
spreadsheet contains names of employees, the store number where the employees work, and their quarterly
sales. This defines a new sub called StoreSales. We need to choose a data type. Starting a For Loop Loops are
some of the most powerful things you can create in any programming language. You probably know about
while and for loops, but what does a do-while loop accomplish? For Each Cell in Range "C2: C51" [a bunch
of stuff] Next Cell This tells Excel to iterate through the cells in the range we specified. We also have this
statement: Even non-programmers can easily add impressive functionality to their spreadsheets with Virtual
Basics for Applications VBA. Just avoid these programming beginner mistakes! However, for the sake of
teaching, I decided to use a For loop with an Exit. Value End If For the most part, you can probably guess
what these statements do. You might not be familiar with ActiveCell. If Excel finds a 1 in this column, then it
takes the contents of the active cell and adds it to Sum1. If it finds a 2, it adds the contents of the active cell to
Sum2. Excel goes through all of these statements in order. Read More is satisfied, it completes the Then
statement. If not, it moves into the next ElseIf. The combination of the loop and the conditionals is what drives
this macro. The loop tells Excel to go through each cell in the selection, and the conditionals tell it what to do
with that cell. Writing Cell Values Finally, we get to write the results of our calculations to cells. Here are the
lines we use to do that: When we run the macro with the Macros button in the Developer tab, we get our sums:
But after breaking it down into its constituent parts, the logic becomes clear. Like any scripting language, it
takes time to get used to the syntax of VBA. When you get stuck, running a Google search is a quick way to
get your VBA questions answered.
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8: VBA Excel Macros
In this blog post, we will learn how to create an ultra-simple macro in Excel to introduce you to the concept. For a more
detailed overview of advanced Excel functions, including creating complicated macros, try the comprehensive Excel
training course for beginners and intermediate users.

First, let me see if I can answer some of your questions. VBA macros for Excel are stored can be stored in a
couple of different places. If the code will be used only for a specific workbook, you store the code in the
workbook. If the code is general purpose for example, adding company logo and page numbers to every
workbook you store the code in a special file called Personal. This file is automatically created the first time
you record a macro and tell it to store the macro in the personal macro workbook. Please note that all macro
code in any open workbook on the machine is available to any other open workbook on the machine. You are
correct, the Object model reference helps you explore all of the different objects that are available to your
VBA code. At the top of the model is the Excel. Underneath that is a hierarchy of objects. For example, each
Excel application hosts 0 to many workbooks. Each workbook has worksheets, each worksheet has columns,
rows, etc. You can use the Object Browser available from the View menu in the VBA development
environment to search through the hierarchy of available objects and learn what you can do with them. You
might have to "enable" the developer tab in program options to see it. One of the other things you should try is
to record a simple macro in Excel. I often have my students record a macro that changes the background color
of a column, then changes the font size and color. Then, go into the VBA editor and take a look at the code
you recorded. Since you know what you recorded, you can often make sense of the code. VBA is very English
like in nature. I recommend that when you read it, you start from the end of the statement and work your way
left. For example, consider this code: Once you get used to reading the code, then the links on Google or other
search engines become more helpful. You can use them to learn how to make decisions in code, store values in
memory temporarily, loop through all rows automatically to process data, etc. I am a Microsoft Certified
Trainer. One of my specialties is teaching VBA programming. You might want to consider an introductory
VBA course many training centers offer 1 or 3 day courses. If you are comfortable learning by reading and
working through exercises, you might want to consider these titles: I can recommend others based upon your
learning style.
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9: Excel Macros Tutorial: How to Create a Simple Macro in Excel
Learn Excel VBA Programming & Macros with free step by step tutorials, download PDF that has + Macros. This is an
ultimate guide to learn Excel VBA. You will also get a list of VBA books and two popular courses from Udemy that are
really helpful for basic and advanced Excel VBA users.

Table of Contents for the downloadable course on Excel macros Chapter 1: You will then be able to modify
and test these components easily step by step in the VBE. Many of our clients have asked us if Excel will ever
become obsolete, here are our thoughts on this. When you select one of the components its properties will
show in the Properties Window and the VBA code that you have created for the selected component will
appear in the Code Window. In this large window you or the Macro Recorder will write macros. You will also
test and fine tune all your macros in the Code Window. You will organize sets of sentences to tell Excel what
to do. Back up, correct and re-test. Excel Macro Recorder The Macro Recorder is the best teacher and it will
be a great assistant writing code for you even when you become an expert at programming in VBA. You will
also run and test the macro that you have recorded. Macros Help and Assistance There is plenty of help and
assistance available within Excel when you develop macros. As you have discovered in the previous lesson the
Macro Recorder is a great teacher and assistant. In this lesson we investigate the two other sources of
assistance within the Visual Basic Editor of Excel: The trigger is called an event. The most frequently used
event is the click on a button. In this lesson you will learn how to add a button to your sheet and how to
connect it to your macro. You will also learn how to start a macro by opening a workbook also called
spreadsheet or Excel file , by closing a workbook and even by changing the value of a cell. VBA Security and
Protection You cannot harm your computer with macros so be bold in experimenting with macros you will
learn more and faster. In this lesson you will learn how to protect you code, your sheets and your workbooks.
Here are interesting tips to make things easier when you start coding. Dealing with Errors VBA tells you
immediately when the code that you have written is wrong. In this lesson you will learn the necessary
vocabulary to deal with errors. Here are other VBA words to add to your vocabulary. You will also learn how
to copy the sheets into another workbooks or to transform a single sheet into a workbook. Moving Around the
Worksheet In this lesson you will improve your VBA vocabulary with 40 some words to work within the
worksheet. You will learn how to change the value of a cell or insert a formula in it. With VBA these tools
become even more powerful. It will empower you to develop sophisticated programs and work extremely
rapidly with very large sets of data. Before learning about variables you develop macros after you develop
programs. Three topics are covered in this lesson. When these tools are no longer sufficient you need to
develop useforms. Userforms Properties and VBA Code In this lesson you will learn how to set the properties
of the userform and you will develop code within the two important events that are " On Activate" and " On
Close". You use them to describe functions and to share information with the user. Text boxex having been
created to handle text you need to discover how to use them with numbers, percentages, currencies, etc. It is a
drop-down list and you will learn how to develop sets of combo boxes where the choices offered in the second
combo box depend on the choice made in the first one. They are called cascading combo boxes. Properties and
VBA code for List Boxes You will develop list boxes when you want to allow the user the possibility of
multiple choices. Properties and VBA code for Spin Buttons You can test different values increasing them
step by step until you find the right one and you do it with a spin button.
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